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ВВЕДЕНИЕ 

 

Системы автоматизированного проектирования (САПР) и авто-

матизированные системы технологической подготовки производ-

ства (АСТПП) являются важнейшими составляющими современных 

технологий, связанных с автоматизацией производства. САПР поз-

воляют устранить несоответствие между требованиями сокращения 

сроков выполнения, повышения качества, снижения себестоимости 

проектных работ и традиционными методами проектирования, что 

особенно важно в автомобилестроении из-за высокой конкуренции 

производителей на мировом рынке автомобилей. 

Применение САПР возможно при наличии инженеров, профес-

сионально владеющих основами автоматизации проектирования, 

компьютерной техникой и способных быть пользователями САПР.  

Цель дисциплины заключается в изложении студентам теорети-

ческих основ САПР и формировании у них навыков пользователя 

САПР. В результате освоения данной дисциплины будущий специ-

алист должен знать комплекс проблем автоматизации проектирова-

ния и производства автомобилей, возможности существующих 

САПР и перспективы их развития, основы графических стандартов, 

структуру и виды обеспечений САПР, компьютерные средства дву-

мерного и трехмерного моделирования автомобилей, их узлов и де-

талей, конкретные программные пакеты для выполнения графиче-

ских работ при проектировании. Он должен уметь практически ра-

ботать с помощью специализированных пакетов программ, 

создавать компьютерные чертежи и модели деталей и узлов авто-

мобиля. 
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1. КОНТРОЛЬНЫЕ ВОПРОСЫ ПО ДИСЦИПЛИНЕ 

 

1. Причины автоматизации проектирования и технологической 

подготовки производства. Краткая история и перспективы развития 

САПР.  

2. Виды обеспечений САПР: структура системы, назначение 

обеспечений. 

3. Основные особенности и черты САПР. 

4. Рабочие станции и сети. Серверы. Накопители на разных но-

сителях. 

5. Дисплеи. Периферийные устройства. 

6. Виды программного обеспечения и их назначение. Системное 

программное обеспечение. Понятие об операционных системах.  

7. Базовое программное обеспечение: требования к нему, терми-

нальный доступ, диалоговое взаимодействие. 

8. Прикладное программное обеспечение. Программное обеспе-

чение, создаваемое пользователем. 

9. Информационное обеспечение. Банки и базы данных. 

10. Системы управления базами данных. 

11. Диалоговые режимы и информационные обмены между под-

системами САПР.  

12. Лингвистическое обеспечение САПР. Классификация языков. 

Языки программирования и проектирования.  

13. Особенности входных языков САПР и языковых процессоров.  

14. Методическое и организационное обеспечение САПР. Назна-

чение, функции, потребители методических средств САПР. Форма, 

организация, состав и логическая структура методических средств.  

15. Нормативно-техническая документация по САПР.  

16. Графические стандарты. 

17. Средства двумерного черчения. Элементы чертежа и методы 

его построения в программах компьютерной графики.  

18. Автоматические средства двумерного черчения.  

19. Библиотеки стандартных графических элементов. 

20. Программа AutoCAD. Графический редактор. Системы коор-

динат и способы указания координат точек.  Команды получения 

справок. 
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21. Команды построения элементов чертежа (отрезков, окружно-

стей, дуг и графических элементов, написания текста) в программе 

AutoCAD.  

22. Команды создания регулярных массивов в программе  

AutoCAD. 

23. Программа AutoCAD. Команды редактирования плоских чер-

тежей: стирание элементов чертежа, перенос, копирование, поворот 

и растяжение графических примитивов, удлинение, обрезка, разрыв 

линий и др.  

24. Программа AutoCAD. Редактирование полилиний. Деление и 

разметка графических объектов. Изменение элементов чертежа.  

25. Программа AutoCAD. Создание, вставка и расчленение бло-

ков, имена блоков. Вставка блоков в другие файлы-чертежи. Гло-

бальная модификация блоков.  

26. Программа AutoCAD. Атрибуты блоков. 

27. Программа AutoCAD. Общие сведения о слоях файла черте-

жа. Свойства линий в слоях. Создание и установка, включение и 

выключение, замораживание и размораживание слоев, текущий 

слой и его выбор.  

28. Программа AutoCAD. Назначение и применение объектной 

привязки. Режимы объектной привязки. Прицел объектной привяз-

ки и изменение его размеров. 

29. Способы работы с командами проставления размеров. Ко-

манды проставления размеров в программе AutoCAD. Корректи-

ровка размерного текста при проставлении размера. 

30. Команды редактирования размеров: обновление, изменение 

положения, редактирование, поворот размерного текста в програм-

ме AutoCAD.  

31. Команды управления видом размеров в программе AutoCAD.  

32. Программа AutoCAD. Размерные переменные и утилиты.  

33. Программа AutoCAD. Команды зуммирования и панорами-

рования, динамического изменения изображения и другие команды 

меню «Вид». 

34. Программа AutoCAD. Управление трехмерными видами. 

Перспектива.  

35. Программа AutoCAD. Команды построения трехмерных объ-

ектов (поверхностей, фигур, тел).  
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36. Команды редактирования трехмерных объектов-моделей в 

программе AutoCAD.  

37. Вспомогательные средства черчения в программе AutoCAD.   

38. Программа AutoCAD. Параметры и способы создания, сохра-

нение и удаление пользовательских систем координат (ПСК).  

39. Программа AutoCAD. Текущая ПСК. Знак ПСК, его виды, 

включение и выключение. 

40. Программа AutoCAD. Виды переменных, их обозначения и 

место хранения значений. Стандартные значения переменных и их 

редактирование. 

41. Вывод компьютерных файлов-чертежей на бумагу в про-

грамме AutoCAD.   

42. Возможности трехмерных систем и их виды. Каркасное мо-

делирование.  

43. Поверхностное моделирование: типы поверхностей, принци-

пы построения составных поверхностей. 

44. Твердотельное моделирование. Метод конструктивного 

представления. Метод граничного представления.  

45. Булевы операции, их использование в твердотельном моде-

лировании.  

46. Особенности конкретных пакетов трехмерного моделирования. 
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2. СПИСОК РЕКОМЕНДУЕМОЙ ЛИТЕРАТУРЫ 

 

Основная 

 

1. Гришкевич, А. И. Основы САПР динамических систем авто-

мобиля : методическое пособие / А. И. Гришкевич, Д. М. Ломако,  

О. С. Руктешель. – Минск : БПИ, 1990. – 43 с. 

2. Дементьев, Ю. В. САПР в автомобиле- и тракторостроении : 

учебник для вузов / Ю. В. Дементьев. – М. : Академия, 2004. – 220 с. 

3. САПР изделий и технологических процессов в машинострое-

нии / Р. А. Аллик [и др.]. – Л. : Машиностроение, 1986. – 187 с. 

4. САПР узлов и механизмов автомобиля : методические указа-

ния к лабораторным работам для студентов специальности 

Т.04.06.00 «Автомобили». – Ч. 1 / О. С. Руктешель [и др.]. – Минск : 

БГПА, 1998. – 84 с. 

5. САПР. Системы автоматизированного проектирования: учеб-

ное пособие для втузов : в 9 кн. / под ред. И. П. Норенкова. – Минск : 

Выш. школа, 1988. 

6. Хокс, Б. Автоматизированное проектирование и производство : 

пер. с англ. / Б. Хокс. – М. : Мир, 1991. – 320 с. 

 

Дополнительная 

 

7. Норенков, И. П. Основы теории и проектирования САПР : 

учебник для вузов / И. П. Норенков, В. Б. Маничев. – М. : Высш. 

школа, 1990. – 156 с. 

8. Петренко, А. И. Основы построения САПР / А. И. Петренко, 

О. И. Семенков. – Киев : Вища школа, 1985. – 140 с. 

9. САПР узлов и механизмов автомобиля : методические указа-

ния к лабораторным работам для студентов специальности 

Т.04.06.00 «Автомобили». – Ч. 2 / О. С. Руктешель, Г. А. Дыко. – 

Минск : БГПА, 1999. – 54 с.  

10. Ступаченко, А. А. САПР технологических операций / А. А. 

Ступаченко. – Л. : Машиностроение, 1988. – 154 с. 
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3. КОНТРОЛЬНАЯ РАБОТА 

 

3.1. Требования к оформлению 

 

Работа должна быть оформлена на листах писчей бумаги формата 

А4 (210 × 297 мм). Листы скрепляются в одну книжку. В качестве об-

ложки используется пластиковая папка-скоросшиватель. За обложкой 

размещается титульный лист, оформленный, как показано в приложе-

нии. За титульным листом должно располагаться оглавление. 

Рисунки и графики выполняются на листах формата А4 или А3 

(графики – на миллиметровой или на писчей бумаге с помощью ком-

пьютерных программ) с применением линейки, лекал и других чер-

тежных инструментов и размещаются после ссылки на них в тексте 

или после соответствующих расчетов. Рисунки должны занимать не 

менее половины страницы. Каждый рисунок должен иметь номер. 

Рекомендуется использовать двухуровневую нумерацию, в которой 

первая цифра – номер задания, а вторая – номер рисунка в задании 

(например, рисунок 1.2 – рисунок 2 к заданию 1). 

Для построения графиков должны быть рассчитаны координаты 

не менее шести точек, наносимых на график. Масштаб построения 

графиков выбирается так, чтобы рационально использовалось про-

странство листа. Сами графики должны быть четкими и понятными 

для изучения. 

Результаты расчетов целесообразно сводить в таблицы, которые 

нумеруются аналогично рисункам. В тексте контрольной работы 

следует делать ссылки на использованные источники, список кото-

рых обязательно приводится в конце работы. 

Все страницы должны быть единообразно пронумерованы, 

начиная с титульного листа. На титульном листе и странице оглав-

ления номер не ставится. 

 

3.2. Задания 

 

Задание 1. Письменно ответить на два теоретических вопроса по 

тематике дисциплины.   

Номера вопросов по вариантам указаны в таблице 3.1. Перечень 

контрольных вопросов приведен в разделе 1. 
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Таблица 3.1 – Варианты задания 1 
 

Вариант Номера вопросов Вариант Номера вопросов 

1 1, 16 31 1, 31 

2 2, 17 32 2, 32 

3 3, 18 33 3, 33 

4 4, 19 34 4, 34 

5 5, 20 35 5, 35 

6 6, 21 36 6, 36 

7 7, 22 37 7, 37 

8 8, 23 38 8, 38 

9 9, 24 39 9, 39 

10 10, 25 40 10, 40 

11 11, 26 41 11, 41 

12 12, 27 42 12, 43 

13 13, 28 43 13, 44 

14 14, 29 44 14, 45 

15 15, 30 45 15, 46 

16 3, 18 46 3, 33 

17 4, 19 47 4, 34 

18 5, 20 48 5, 35 

19 6, 21 49 6, 36 

20 7, 22 50 7, 37 

21 8, 23 51 8, 38 

22 9, 24 52 9, 39 

23 10, 25 53 10, 40 

24 11, 26 54 11, 42 

25 12, 27 55 12, 43 

26 13, 28 56 13, 44 

27 14, 29 57 14, 45 

28 15, 30 58 15, 46 

29 15, 30 59 15, 46 

30 15, 30 60 15, 46 

 

Задание 2. Построить вертикальную упругую характеристику 

гидропневматической подвески большегрузного самосвала. 
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Варианты исходных данных представлены в таблице 3.2. 
 

Таблица 3.2 – Варианты исходных данных для задания 2 
 

Вариант 

Частота собственных 

колебаний 

подрессоренной мас-

сы автомобиля 

ν0 , Гц 

Подрессоренная мас-

са автомобиля, 

приходящаяся 

на подвеску моста  

Mп , кг 

Передаточное 
отношение  

направляющего 
устройства  
подвески 

iну 

1 2 3 4 

1 1,90 17 795 1,36 

2 1,40 120 900 1,47 

3 1,80 22 800 1,40 

4 1,60 116 000 1,36 

5 1,50 16 350 1,41 

6 1,70 16 205 1,42 

7 1,20 118 500 1,44 

8 1,80 106 500 1,46 

9 1,30 24 050 1,30 

10 1,45 125 100 1,35 

11 1,24 116 560 1,31 

12 1,32 24 000 1,39 

13 1,85 17 795 1,43 

14 1,90 24 100 1,37 

15 1,20 24 060 1,45 

16 1,70 54 270 1,37 

17 1,40 24 090 1,36 

18 1,80 116 800 1,30 

19 1,50 22 800 1,34 

20 1,25 11 800 1,47 

21 1,56 156 667 1,50 

22 1,75 14 500 1,48 

23 1,22 114 000 1,51 

24 1,26 18 700 1,90 

25 1,33 55 000 1,79 

26 1,29 17 900 2,00 

27 1,31 18 400 1,10 
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Окончание таблицы 3.2 

 
1 2 3 4 

28 1,42 114 000 1,25 

29 1,48 125 167 1,27 

30 1,54 110 000 1,48 

31 1,23 117 667 1,56 

32 1,39 26 100 2,23 

33 1,57 26 300 2,15 

34 1,66 114 000 1,92 

35 1,69 116 667 1,98 

36 1,72 43 333 2,01 

37 1,61 16 900 1,88 

38 1,53 125 167 1,96 

39 1,28 17 560 1,89 

40 1,34 26 000 1,72 

41 1,55 43 333 1,70 

42 1,27 19 320 1,55 

43 1,31 19 700 2,27 

44 1,73 17 530 2,20 

45 1,46 31 733 2,17 

46 1,91 17 780 2,02 

47 1,83 16 310 2,10 

48 1,88 24 090 1,81 

49 1,26 23 300 1,73 

50 1,32 17 640 1,66 

51 1,35 20 667 1,54 

52 1,75 18 100 1,62 

53 1,31 35 000 1,51 

54 1,37 34 600 1,48 

55 1,41 41 000 1,77 

56 1,54 26 300 1,62 

57 1,42 250 000 1,44 

58 1,55 25 700 1,39 

59 1,43 24 520 1,31 

60 1,90 17 500 3,01 
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3.3. Методические указания к выполнению задания 2 

 

Вертикальная упругая характеристика подвески автомобиля 

представляет зависимость между вертикальной нагрузкой на под-

веску и ее деформацией в приведении к оси колеса. 

Плавность хода автомобиля характеризуется энергией колебаний 

и ее распределением по частотным диапазонам. Водитель лучше 

переносит низкочастотные колебания в диапазоне от 0,8 до 1,5 Гц. 

В диапазоне от 4 до 8 Гц – наихудшая переносимость колебаний 

человеком. Поэтому частота собственных колебаний подрессорен-

ной массы автомобиля при номинальной нагрузке должна состав-

лять от 0,8 до 1,2 Гц для легковых автомобилей и от 1,2 до 1,9 Гц 

для грузовых автомобилей. 

Частота собственных колебаний связана с жесткостью подвески 

следующей зависимостью 

 

0 0 п 0 у01/ 2р / 1/ 2р ,v C М C gF  

 

где C0 – жесткость подвески груженого автомобиля в положении 

статического равновесия, Н/м; 

π = 3,1415926; 

Mп – подрессоренная масса, приходящаяся на подвеску, кг; 

g = 9,81 м/с
2
; 

Fy0 – статическая вертикальная нагрузка на подвеску груженого 

автомобиля, Н. 

Жесткость подвески может быть определена как производная от 

вертикальной нагрузки по деформации h:  С0 = dFy / dh. 

Вертикальную упругую характеристику подвески можно рас-

считать по выражению 

 
2 2

у у0 0 0exp 4р / ,F F v h h g                       (3.1) 

 

где Fy – текущая вертикальная нагрузка на подвеску, Н; 

h – текущая деформация подвески, м; 

hо – статическая деформация подвески, м. 

Статическая деформация подвески рассчитывается по формуле 
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2 2
0 0/ 4р .h g v  

 

Статическая вертикальная нагрузка на подвеску определяется 

 

y0 п .F M g  

 

В соответствии с формулой (3.1) рассчитываются значения 

нагрузки Fy при изменении деформации h от 0 до величины полной 

деформации подвески, равной сумме статической и динамической 

деформаций (h0 + hд). Для грузовых автомобилей можно принимать 

эти деформации равными друг другу (hд = h0). Результаты расчетов 

заносятся в таблицу 3.3.  

 

Таблица 3.3 – Результаты расчетов упругой характеристики подвески 

 

h, м 0              h0 + hд 

Fy, Н                

 

Число рассчитанных значений должно быть не менее 15. По дан-

ным таблицы 3.3 строится график вертикальной упругой характери-

стики подвески Fy = f(h). 

Максимальная вертикальная нагрузка на подвеску Fy max  ограни-

чивается с учетом коэффициента динамичности  kд: 

 

у max д у0 ,F k F  

 

где kд принимается от 1,75 до 2,5.  

Значение Fy max откладывается по оси ординат, и через данную 

точку проводится горизонталь. Она будет ограничивать величину Fy 

на графике характеристики. По оси абсцисс откладывается статиче-

ская деформация h0, и через полученную точку A проводится вер-

тикальная линия до пересечения с графиком. 

В подвеске для ограничения деформаций устанавливаются буфе-

ры сжатия и отбоя. Деформация подвески в момент срабатывания 

буфера сжатия 
б
сжh  может быть определена 
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б max
сж сж0,7h h  

 

где 
max
сжh  – максимальная деформация на ходе сжатия, м; 

max
сжh  =  

= (0,75–1)hд. 

В момент срабатывания буфера отбоя деформация равна 

 
б max
отб отб0,7 ,h h  

 

где 
max
отбh  – максимальная деформация на ходе отбоя, м; 

max
отбh  =  

= (0,75–1)h0. Для грузовых автомобилей можно принимать 
max
отбh  

≈  

≈ 
max
сжh  ≈ hд. 

Величина 
б
отбh  откладывается от точки h0 влево по оси абсцисс, и 

через нее проводится вертикаль до пересечения с графиком (точка B). 

Из этой точки проводится плавная кривая в начало координат. Тем 

самым ограничивается ход отбоя. 

Необходимость установки буфера сжатия должна быть предва-

рительно проверена. Для этого на оси абсцисс от точки статической 

деформации откладывается вправо величина максимальной дефор-

мации сжатия 
max
сжh . Через полученную точку проводится вертикаль 

до пересечения с графиком. Если график будет пересечен при  

Fy  ≥ Fy max (точка С), то в установке буфера сжатия нет необходимо-

сти (деформация на ходе сжатия ограничивается величиной макси-

мальной нагрузки). В противном случае по оси абсцисс от точки h0 

вправо откладывается величина 
б
сжh , 

и через нее проводится верти-

каль до пересечения с графиком в точке D. Точка D соединяется 

плавной кривой с точкой пересечения горизонтали Fy max и вертика-

ли 
max
сжh  (точка E). 

Скорректированную упругую характеристику подвески далее 

следует перестроить в характеристику упругого элемента. Для 

этого применяются формулы 
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э у ну/F F i  

 

и 

 

э нуh h i , 

 

где Fэ и hэ – нагрузка и деформация упругого элемента; 

iну – передаточное отношение направляющего устройства для 

упругого элемента. 

По приведенным формулам пересчитываются данные из табли-

цы 3.3, и результаты заносятся в таблицу 3.4. 

 

Таблица 3.4 – Результаты расчетов характеристики упругого элемента 

 

hэ, м 0                

Fэ, Н 0                
 

 По данным таблицы 3.4 строится график характеристики упру-

гого элемента Fэ = f(hэ). Данный график рекомендуется строить на 

одном листе с графиком Fy = f(h). 

Для выполнения оптимизации конструктивных параметров 

упругого элемента подвески с помощью компьютерной программы 

необходимо преобразовать характеристику упругого элемента в 

безразмерный вид. Значения деформации hэ и нагрузки Fэ из табли-

цы 3.4 используются для получения значений деформации hэw и 

безразмерной силы Fэw по формулам 

 

э э э0wh h h                                         (3.2) 
 

и 
 

э э э0 э0/ .wF F F F                                 (3.3) 

 

Заполняется таблица 3.5. 
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Таблица 3.5 – Результаты расчетов безразмерной характеристики 

упругого элемента 

 

hэw, м –hэw       0        hэw 

Fэw, Н –1       0        1 

 
Примечание. Безразмерная сила Fэw будет иметь диапазон изменения от 

–1 до 1 в том случае, если коэффициент динамичности kд принят равным 2. 

 

По данным таблицы 3.5 строится график безразмерной характе-

ристики упругого элемента Fэw= f(hэw). Данные из таблицы 3.5 в 

дальнейшем используются при заполнении файла исходных данных 

для компьютерной программы оптимизации параметров упругого 

элемента.  
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4. ЛАБОРАТОРНЫЕ РАБОТЫ 
 

Работа рассчитана на 18 часов и состоит из нескольких занятий. 

Содержание шести лабораторных занятий и методические указания 

к их выполнению описаны в [4]. 

Лабораторное занятие № 7 на тему «Работа с трехмерными объ-

ектами» состоит из двух лабораторных работ. 

 

Лабораторная работа № 1 
 

КОМПЬЮТЕРНАЯ ГРАФИКА 

В ПРОГРАММНОМ ПАКЕТЕ AUTOCAD 
 

Цель работы: приобретение студентами практических навыков 

работы в пакете автоматизации графических работ AutoCAD. 
 

Построение трехмерных объектов 
 

Команда построения трехмерного твердотельного параллелепи-

педа BOX 

Командная строка: BOX 

Выпадающее меню: Draw → Solids → Box 

Инструментальная панель: Solids → Box 

При вызове команды система выдает первый запрос:  

Specify corner of box or [CEnter] <0,0,0>: (Укажите вершину па-

раллелепипеда или [Центр] <0,0,0>:) 

Любым известным способом указать положение одной из вер-

шин создаваемого параллелепипеда или нажать клавишу ENTER 

для задания координат, предложенных по умолчанию. 

СЕ используется для задания положения центра создаваемого па-

раллелепипеда; при этом система выдает дополнительный запрос: 

Specify center of box <0,0,0>: (Задайте центр параллелепипеда 

<0,0,0>:) 

Любым известным способом задать положение центра паралле-

лепипеда или нажать клавишу ENTER для задания координат, 

предложенных по умолчанию. 

Второй запрос системы: 

Specify corner or [Cube/Length]: (Укажите вершину или 

[Куб/Длина]:) 
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Любым известным способом указать положение другой верши-

ны создаваемого параллелепипеда. В результате указания второй 

точки должно быть задано диагональю основание параллелепипеда. 

С используется для построения куба; при этом система выдает 

дополнительный запрос: 

Specify length: (Задайте длину:) 

Необходимо ввести числовое значение длины ребра куба или за-

дать длину ребра куба, указав на графическом экране две произ-

вольные точки. 

L используется для задания размеров параллелепипеда; при этом 

система последовательно выдает следующие запросы: 

Specify length: (Задайте длину:) 

Specify width: (Задайте ширину:) 

Необходимо ввести числовые значения соответствующих пара-

метров параллелепипеда или задать размеры параллелепипеда, ука-

зав на графическом экране по две произвольные точки для каждого 

из параметров. 

Следующий запрос системы: 

Specify height: (Задайте высоту:) 

Нужно ввести числовое значение высоты создаваемого паралле-

лепипеда или задать высоту параллелепипеда, указав на графиче-

ском экране две произвольные точки. 

 

Команда построения твердотельного шара SPHERE 

Командная строка: SPHERE 

Выпадающее меню: Draw → Solids → Sphere 

Инструментальная панель: Solids → Sphere 

При вызове команды система выдает первый запрос: 

Specify center of sphere <0,0,0>: (Задайте центр шара <0,0,0>:) 

Любым известным способом указать положение центра создава-

емого шара либо нажать клавишу ENTER для задания координат 

центра шара, предложенных по умолчанию. 

Второй запрос системы: 

Specify radius of sphere or [Diameter]: (Задайте радиус шара или 

[Диаметр]:) 

Необходимо ввести числовое значение радиуса шара или задать 

радиус шара, указав на графическом экране произвольную точку. 

D используется, если необходимо задать диаметр шара. 
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Команда построения прямого твердотельного цилиндра с осью, 

параллельной оси Z текущей системы координат, CYLINDER 

Командная строка: CYLINDER 

Выпадающее меню: Draw → Solids → Cylinder 

Инструментальная панель: Solids → Cylinder 

При вызове команды система выдает первый запрос: 

Specify center point for base of cylinder or [Elliptical] <0,0,0>: (За-

дайте центр основания цилиндра или [Эллиптический] <0,0,0>:) 

Любым известным способом указать положение центра основа-

ния создаваемого цилиндра или нажать клавишу ENTER для зада-

ния координат, предложенных по умолчанию. 

Е используется для построения эллиптического цилиндра, при 

этом система выдает дополнительный запрос: 

Specify axis endpoint of ellipse for base of cylinder or [Center]: (За-

дайте конец оси эллиптического основания цилиндра или [Центр]:) 

Необходимо задать форму эллипса способами, аналогичными 

тем, которые применяются при построении эллипса командой 

ELLIPSE. 

Второй запрос системы: 

Specify radius for base of cylinder or [Diameter]: (Задайте радиус 

основания цилиндра или [Диаметр]:) 

Необходимо ввести числовое значение радиуса основания ци-

линдра или задать радиус основания цилиндра, указав на графиче-

ском экране произвольную точку. 

D используется, если необходимо задать диаметр основания ци-

линдра. 

Третий запрос системы: 

Specify height of cylinder or [Center of other end]: (Задайте высо-

ту цилиндра или [Центр другого конца]:) 

Нужно ввести числовое значение высоты цилиндра или задать 

высоту цилиндра, указав на графическом экране две произвольные 

точки. 

С используется для задания положения центра второго основа-

ния; при этом система выдает запрос: 

Specify center of other end of cylinder: (Задайте центр другого 

конца цилиндра:) 

Любым известным способом задать положение центра второго 

основания цилиндра. 
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Команда построения твердотельного конуса CONE 

Командная строка: CONE 

Выпадающее меню: Draw → Solids → Cone 

Инструментальная панель: Solids → Cone 

При вызове команды система выдает первый запрос:  

Specify center point for base of cone or [Elliptical] <0,0,0>: (За-

дайте центр основания конуса или [Эллиптический] <0,0,0>:) 

Необходимо любым известным способом указать положение 

центра основания создаваемого конуса или нажать клавишу ENTER 

для задания координат, предложенных по умолчанию. 

Е используется для построения эллиптического конуса; при этом 

система выдает дополнительный запрос: 

Specify axis endpoint of ellipse for base of cone or [Center]: (Задай-

те конец оси эллиптического основания конуса или [Центр]:) 

Необходимо задать форму эллипса способами, аналогичными 

тем, которые применяются при построении эллипса командой 

ELLIPSE. 

Второй запрос системы: 

Specify radius for base of cone or [Diameter]: (Задайте радиус ос-

нования конуса или [Диаметр]:) 

Нужно ввести числовое значение радиуса основания конуса либо 

задать радиус основания конуса, указав на графическом экране про-

извольную точку. 

D используется, если необходимо задать диаметр основания ко-

нуса. 

Третий запрос системы: 

Specify height of cone or [Apex]: (Задайте высоту конуса или 

[Вершина]:) 

Ввести числовое значение высоты цилиндра или задать высоту 

цилиндра, указав на графическом экране две произвольные точки. 

А используется для задания положения вершины конуса; при 

этом система выдает запрос: 

Specify apex point: (Задайте вершину:) 

Любым известным способом необходимо задать положение вер-

шины конуса. 
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Команда построения твердотельной прямой призмы (клина) с 

основанием в виде прямоугольного треугольника, параллельным 

плоскости XZ текущей системы координат, WEDGE 

Командная строка: WEDGE 

Выпадающее меню: Draw → Solids → Wedge 

Инструментальная панель: Solids → Wedge 

При вызове команды система выдает первый запрос: 

Specify first corner of wedge or [CEnter] <0,0,0>: (Укажите 

первую вершину клина или [Центр] <0,0,0>:) 

Любым известным способом указать положение одной из вер-

шин нижней грани призмы либо нажать клавишу ENTER для зада-

ния координат, предложенных по умолчанию. При указании поло-

жения первой вершины призма в дальнейшем будет построена та-

ким образом, что плоскость ее вертикальной грани будет проходить 

через данную вершину. 

СЕ используется для задания положения центра создаваемой 

призмы – точки пересечения диагоналей наклонной грани призмы; 

при этом система выдает дополнительные запросы:  

Specify center of wedge <0,0,0>: (Задайте центр клина <0,0,0>:) 

Любым известным способом задать положение центра призмы 

или нажать клавишу ENTER для задания координат, предложеных 

по умолчанию; 

Specify opposite corner or [Cube/Length]: (Задайте противопо-

ложную вершину или [Куб/Длина]:) 

При указании положения противоположной вершины создавае-

мая призма будет вписана в прямоугольный параллелепипед, диа-

гонали которого пересекаются в заданном ранее центре клина и од-

на из вершин которого совпадает с указанной точкой. Собственно 

призма получается как результат отсечения половины данного па-

раллелепипеда секущей плоскостью, проходящей через его центр и 

пару ребер и перпендикулярной плоскости XZ. При этом отсекается 

та часть  параллелепипеда, которой принадлежит указанная верши-

на. Необходимо любым известным способом задать положение про-

тивоположной вершины либо нажать клавишу ENTER для задания 

координат, предложенных по умолчанию. 

С используется для построения призмы, вписанной в куб;  

L используется для задания длины нижней грани призмы. 

Второй запрос системы: 
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Specify corner or [Cube/Length]: (Укажите вершину или 

[Куб/Длина]:) 

Любым известным способом необходимо указать положение 

другой вершины нижней грани создаваемой призмы. 

Следующий запрос системы: 

Specify height: (Задайте высоту:) 

Необходимо ввести числовое значение высоты боковой грани 

создаваемой призмы или задать высоту призмы, указав на графиче-

ском экране две произвольные точки. 
 

Команда построения твердотельного тора TORUS 

Командная строка: TORUS 

Выпадающее меню: Draw → Solids → Torus 

Инструментальная панель: Solids → Torus 

При вызове команды система выдает первый запрос: 

Specify center of torus <0,0,0>: (Задайте центр тора <0,0,0 >:) 

Необходимо любым известным способом указать положение 

центра создаваемого тора (центра направляющей окружности) или 

нажать клавишу ENTER для задания координат, предложенных по 

умолчанию. 

Второй запрос системы: 

Specify radius of torus of [Diameter]: (Задайте радиус направля-

ющей окружности или [Диаметр]:) 

Необходимо ввести числовое значение радиуса направляющей 

окружности (расстояния от центра образующей окружности до цен-

тра тора) тора или задать радиус, указав на графическом экране 

произвольную точку. 

D используется, если необходимо задать диаметр направляющей 

окружности тора. 

Следующий запрос системы: 

Specify radius of tube or [Diameter]: (Задайте радиус образующей 

окружности или [Диаметр]:) 

Необходимо ввести числовое значение радиуса образующей 

окружности тора или задать радиус, указав на графическом экране 

произвольную точку. 
 

Команда построения твердотельного объекта путем выдавлива-

ния плоского контура EXTRUDE 

Командная строка: EXTRUDE 
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Выпадающее меню: Draw → Solids → Extrude 

Инструментальная панель: Solids → Extrude 

При вызове команды система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Необходимо указать объекты, выдавливанием которых необхо-

димо создать твердые тела, либо нажать клавишу ENTER для за-

вершения выбора объектов. 

Следующий запрос системы: 

Specify height of extrusion or [Path]: (Задайте высоту выдавлива-

ния или [Путь]:) 

Необходимо ввести числовое значение расстояния, на которое 

должно быть выдавлено тело, либо задать расстояние выдавлива-

ния, указав на графическом экране две произвольные точки. 

Р используется для выдавливания объекта вдоль направляющей; 

при этом система выдает дополнительный запрос: 

Select extrusion path: (Укажите путь выдавливания:) 

Нужно указать объект, вдоль которого необходимо выдавить ис-

ходный контур. 

Следующий запрос системы: 

Specify angle of taper for extrusion <0>: (Задайте угол сходимо-

сти при выдавливании <0>:) 

Возможные варианты: ввести числовое значение угла суживания 

создаваемого тела (угла между направлением выдавливания и обра-

зующими боковых поверхностей тела); задать угол, указав на гра-

фическом экране две произвольные точки; нажать клавишу ENTER 

для задания значения, предложенного по умолчанию. 

Исходными объектами для выдавливания могут являться плоские 

грани (примитивы 3D FACES), замкнутые полилинии, многоугольни-

ки, окружности, эллипсы, замкнутые сплайны, кольца и области. 

При создании твердых тел исходные контуры удаляются. 

Объектами – направляющими, вдоль которых может произво-

диться выдавливание, – могут служить отрезки, окружности, дуги 

окружностей, эллипсы, дуги эллипсов, полилинии или сплайны. 

При выдавливании контура вдоль направляющей угол его наклона 

относительно направляющей остается постоянным. 

Значение угла суживания выдавливаемого тела должно лежать в 

пределах от –90° до +90°, причем это значение не должно задавать 

создание самопересекающегося тела. 
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Команда построения твердого тела вращения REVOLVE 

Командная строка: REVOLVE 

Выпадающее меню: Draw → Solids → Revolve  

Инструментальная панель: Solids → Revolve  

При вызове команды система выдает повторяющиеся запросы:  

Select objects: (Укажите объекты:) 

Возможные ответы: указать объекты, вращением которых необ-

ходимо создать твердые тела, либо нажать клавишу ENTER для за-

вершения выбора объектов. 

Следующий запрос системы: 

Specify start point for axis of revolution or define axis by [Object/ 

X (axis)/Y (axis)]: (Задайте начальную точку оси вращения или за-

дайте ось по [Объект/Х ось/Y ось]:) 

Необходимо любым известным способом указать положение 

первой точки, принадлежащей оси вращения. 

О используется для задания оси, определяемой некоторым объ-

ектом; при этом система выдает дополнительный запрос: 

Select an object: (Укажите объект:) 

Необходимо указать объект, который определяет направление 

оси вращения. 

X используется для задания оси вращения, совпадающей с осью X 

текущей системы координат; 

Y используется для задания оси вращения, совпадающей с осью Y 

текущей системы координат.  

Следующий запрос системы: 

Specify endpoint of axis: (Задайте конечную точку оси:) 

Любым известным способом нужно указать положение второй 

точки, принадлежащей оси вращения. 

Следующий запрос системы: 

Specify angle of revolution <360>: (Задайте угол вращения 

<360>:) 

Возможные ответы: ввести числовое значение угла, на который 

необходимо повернуть исходный контур для получения требуемого 

тела; задать угол поворота, указав на графическом экране две про-

извольные точки; нажать клавишу ENTER для задания значения, 

предложенного по умолчанию. 



 25 

Исходными объектами для вращения могут служить замкнутые 

полилинии, многоугольники, окружности, эллипсы, замкнутые 

сплайны, кольца и области. 

При создании твердых тел вращения исходные контуры удаляются. 

Объектами, задающими направление оси вращения, могут слу-

жить отрезки и плоские полилинии. В последнем случае за ось вра-

щения принимается линия, проходящая через начальную и конеч-

ную точки полилинии. 

 

Общие средства редактирования трехмерных объектов 

 

Для редактирования любых трехмерных объектов могут приме-

няться такие универсальные команды, как PROPERTIES, COPY, 

ERASE, EXPLODE, MOVE, OOPS, REDO, SCALE, UNDO, а 

также средство редактирования Grips. Работа этими средствами ве-

дется так же, как и при плоском черчении.  

При использовании команды ARRAY применительно к трех-

мерным объектам создается массив объектов, все соответствующие 

точки которых расположены на одной плоскости, параллельной 

плоскости XY текущей системы координат. Поэтому с помощью 

данной команды нельзя создать массив, элементы которого имеют 

различное расположение относительно оси Z. 

При использовании команды MIRROR применительно к трех-

мерным объектам создается их зеркальное отражение относительно 

плоскости, проходящей через заданную ось симметрии и перпенди-

кулярной плоскости XY текущей системы координат. 

При использовании команды ROTATE применительно к трех-

мерным объектам производится их поворот относительно оси, про-

ходящей через заданную точку и перпендикулярной плоскости XY 

текущей системы координат. 

При использовании команды STRETCH применительно к поверх-

ностям производится изменение положения их узловых точек. Изме-

нение формы твердотельных объектов с помощью данной команды 

невозможно (действие команды сводится к перемещению объекта). 

 

Команда создания фаски (скошенной части кромки) твердого те-

ла CHAMFER 

Командная строка: CHAMFER 
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Выпадающее меню: Modify → Chamfer  

Инструментальная панель: Modify → Chamfer 

При вызове команды система выдает сообщение и первый запрос: 

(TRIM mode) Current chamfer Distl = 10.0000, Dist2 = 10.0000  

Select first line or [Polyline/Distance/Angle/Trim/Method]: ((режим 

TRIM) Текущие размеры фаски Разм1 = 10.0000, Разм2 = 10.0000 

Укажите первую линию или [...]:) 

Необходимо указать общее ребро граней, между которыми необ-

ходимо создать фаску. 

Следующий запрос системы:  

Base surface selection... 

Enter surface selection option [Next/OK (current)] <OK>: 

(Выбор базовой поверхности... 

Введите опцию выбора поверхности [Следующая/Да (текущая)] 

<ДА>:) 

При выполнении данной команды система создает фаски только 

на ребрах, ограничивающих одну (базовую) грань тела. 

Необходимо либо нажать клавишу ENTER для задания парамет-

ра, предложенного по умолчанию. 

О используется для задания в качестве базовой текущей грани 

тела (подсвеченной на графическом экране); 

N используется для выбора в качестве текущей соседней грани тела. 

Следующий запрос системы: 

Specify base surface chamfer distance <10.0000>: (Задайте размер 

фаски на базовой поверхности <10.0000>:) 

Необходимо либо ввести числовое значение линейного размера 

фаски по базовой грани, либо задать размер фаски, указав на графи-

ческом экране две произвольные точки, либо нажать клавишу 

ENTER для задания значения, предложенного умолчанию. 

Следующий запрос системы: 

Specify other surface chamfer distance <10.0000>: (Задайте раз-

мер фаски на другой поверхности <10.0000>:) 

Необходимо либо ввести числовое значение линейного размера 

фаски по второй грани, либо задать размер фаски, указав на графи-

ческом экране две произвольные точки, либо нажать клавишу 

ENTER для задания значения, предложенного по умолчанию. 

Далее система выдает следующие повторяющиеся запросы:  

Select an edge or [Loop]: (Укажите ребро или [Петля]:) 
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Нужно последовательно указать все ребра базовой грани, по кото-

рым необходимо создать фаски, или нажать клавишу ENTER для фор-

мирования фасок на заданных ребрах и завершения работы с командой. 

L задается для создания фасок по всем ребрам базовой грани.  

В этом случае система выдает повторяющиеся запросы: 

Select an edge loop or [Edge]: (Укажите ребро контура или [Ребро]:) 

Необходимо указать одно из ребер базовой грани. 

Е используется для возврата в режим указания отдельных ребер;  

Select an edge loop or [Edge]: (Укажите ребро контура или [Ребро]:) 

Нужно нажать клавишу ENTER для формирования фасок на за-

данных ребрах и завершения работы с командой. 

При создании фасок между гранями твердых тел опции, предла-

гаемые системой в первом запросе, не используются. 

 

Команда FILLET позволяет скруглять внутренние и внешние 

углы твердого тела 

Командная строка: FILLET  

Выпадающее меню: Modify → Fillet  

Инструментальная панель: Modify → Fillet 

При вызове команды система выдает сообщение и первый запрос: 

Current settings: Mode = TRIM, Radius = 10.0000 Select first object 

or [Polyline/Radius/Trim]: (Текущие установки: Режим = TRIM, Ра-

диус = 10.0000 Укажите первый объект или [...]:) 

Нужно указать ребро твердого тела, на котором необходимо со-

здать скругление. 

Следующий запрос системы: 

Enter fillet radius <10.0000>: (Введите радиус скругления 

<10.0000>:) 

Необходимо ввести числовое значение радиуса скругления, или 

задать радиус скругления, указав на графическом экране две произ-

вольные точки, или нажать клавишу ENTER для задания значения, 

предложенного по умолчанию. 

Далее система выдает повторяющиеся запросы: 

Select an edge or [Chain/Radius]: (Задайте ребро или [Цепь/Радиус]:) 

Необходимо последовательно указать все ребра, на которых 

необходимо создать скругления, либо нажать клавишу ENTER для 

формирования скруглений на заданных ребрах и завершения рабо-

ты с командой. 
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С используется для задания скруглений ребер, образующих тело; 

при этом система выдает повторяющиеся запросы: 

Select an edge chain or [Edge/Radius]: (Укажите ребро в цепочке 

или [Ребро/Радиус]:) 

Необходимо указать одно из ребер, продолжающих ранее вы-

бранное. 

Е используется для возврата в режим указания отдельных ребер; 

R используется для задания нового радиуса скругления; 

Select an edge loop or [Edge]: (Укажите ребро контура или [Ребро]:) 

Нужно нажать клавишу ENTER для формирования скруглений 

на заданных ребрах и завершения работы с командой. 

R используется для задания нового радиуса скругления, при этом 

система выдает запрос: 

Enter fillet radius <10.0000>: (Введите радиус скругления 

<10.0000>:) 

Можно либо ввести числовое значение радиуса скругления, либо 

задать радиус скругления, указав на графическом экране две произ-

вольные точки, либо нажать клавишу ENTER для задания значения, 

предложенного по умолчанию. 

При скруглении ребер твердых тел опции, предлагаемые систе-

мой в первом запросе, не используются. 

 

Команда SLICE позволяет разрезать набор тел плоскостью и при 

необходимости удалять отсеченные части объектов 

Командная строка: SLICE 

Выпадающее меню: Draw →Solids → Slice 

Инструментальная панель: Solids → Slice 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 

Необходимо указать объект. 

Далее система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Необходимо указать объекты или нажать клавишу ENTER для 

завершения указания объектов. 

Следующий запрос системы: 

Specify first point on slicing plane by [Object/Zaxis/View/XY/YZ/ZX/ 

3points] <3points>: (Задайте первую точку секущей плоскости 

[Объект/ось Z/Вид/XY/YZ/ZX/3 точки] <3 точки>:) 
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Необходимо любым известным способом указать первую точку, 

лежащую на секущей плоскости; при этом система выдает дополни-

тельные запросы: 

Specify second point on plane: (Задайте вторую точку на плоскости:) 

Необходимо любым известным способом указать вторую точку, 

лежащую на секущей плоскости; 

Specify third point on plane: (Задайте третью точку на плоскости:) 

Возможные ответы: любым известным способом указать третью 

точку, лежащую на секущей плоскости; нажать клавишу ENTER 

для задания параметра по умолчанию.  

О используется для задания секущей плоскости, совпадающей с 

плоскостью объекта; при этом система выдает дополнительный запрос: 

Select a circle, ellipse, arc, 2-spline or 2D-polyline: (Укажите 

окружность, эллипс, дугу, 2-сплайн или 2D-полилини) 

Необходимо указать объект одного из перечисленных типов, 

плоскость расположения которого следует принять в качестве се-

кущей плоскости. 

Z используется для задания секущей плоскости по перпендикуляр-

ной к ней оси; при этом система выдает дополнительные запросы:  

Specify a point on the section plane: (Задайте точку на секущей 

плоскости:)  

Любым известным способом необходимо указать точку, лежа-

щую на требуемой секущей плоскости; 

Specify a point on the Z axis (normal) of the plane: (Задайте точку 

на оси Z (нормали) плоскости:) 

Любым известным способом необходимо указать точку, лежа-

щую на перпендикуляре к секущей плоскости, проходящем через 

первую указанную точку. 

V используется для задания секущей плоскости, параллельной 

плоскости видового экрана; при этом система выдает дополнитель-

ный запрос: 

Specify a point on the current view plane <0,0,0>: (Задайте точку 

на плоскости вида <0,0,0>:) 

Необходимо любым известным способом указать точку, через 

которую должна пройти секущая плоскость, параллельная плоско-

сти видового экрана, либо нажать клавишу ENTER для задания ко-

ординат точки, предложенных по умолчанию. 



 30 

XY используется для задания секущей плоскости, параллельной 

плоскости XY текущей системы координат; при этом система выда-

ет дополнительный запрос: 
Specify point on XY plane <0,0,0>: (Задайте точку на плоскости XY 

<0,0,0>:) 
Возможные ответы: любым известным способом указать точку, 

через которую должна пройти секущая плоскость, параллельная 
плоскости XY; нажать клавишу ENTER для задания координат точ-
ки, предложенных по умолчанию. 

YZ используется для задания секущей плоскости, параллельной 
плоскости YZ текущей системы координат;  

ZX используется для задания секущей плоскости, параллельной 
плоскости ZX текущей системы координат. 

Следующий запрос системы: 
Specify a point on desired side of the plane or [keep Both sides]: (За-

дайте точку на нужной стороне от плоскости или [Обе стороны]:) 
Любым известным способом необходимо указать точку, лежа-

щую с той стороны от секущей плоскости, где следует сохранить 
части твердотельных объектов. 

В используется, если необходимо сохранить обе части исходных 
объектов, разделенные секущей плоскостью, в виде самостоятель-
ных объектов. 

После этого система выполнит заданные операции и завершит 

работу с командой. 
 

Команда UNION позволяет создать новый твердотельный объект 
путем объединения нескольких объектов 

Командная строка: UNION 
Выпадающее меню: Modify → Solids Editing → Union 
Инструментальная панель: Solids Editing → Union 
При вызове команды система выдает повторяющиеся запросы: 
Select objects: (Укажите объекты:) 
Необходимо указать объекты, которые необходимо объединить в 

один объект, либо нажать клавишу ENTER для объединения ранее 
указанных объектов и завершения работы с командой. Если указан-
ные пользователем твердотельные объекты не пересекаются и не 
касаются друг друга, то система выполнит формальное объединение 
этих тел. При этом вновь созданный объект будет восприниматься 
системой как единое целое, хотя в физическом смысле такой объект 
будет являться набором отдельных невзаимосвязанных тел. 
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Команда SUBTRACT позволяет создать новые области или 

твердотельный объект путем исключения (вычитания) аналогичных 

объектов 

Командная строка: SUBTRACT 

Выпадающее меню: Modify → Solids Editing → Subtract 

Инструментальная панель: Solids Editing → Subtract 

При вызове команды система выдает повторяющиеся запросы: 

Select solids and regions to subtract from ... Select objects: (Указа-

ние тел и областей для вычитания из... Укажите объекты:) 

Необходимо указать исходные объекты, из которых необходимо 

исключить другие объекты, либо нажать клавишу ENTER для за-

вершения указания исходных объектов. 

Следующие запросы системы: 

Select solids and regions to subtract... Select objects: (Указание тел 

и областей для вычитания... Укажите объекты:) 

Возможные ответы: указать объекты, которые необходимо вы-

честь из исходных объектов, либо нажать клавишу ENTER для пре-

кращения указания вычитаемых объектов и завершения работы с 

командой. 

Вычитаемые объекты после выполнения команды удаляются. 

Если исходное и вычитаемое тела не пересекаются, то в резуль-

тате выполнения команды SUBTRACT будет просто удалено вычи-

таемое тело. 

 

Команда INTERSECT позволяет создать новый твердотельный 

объект, который является общей частью всех указанных объектов  

Командная строка: INTERSECT 

Выпадающее меню: Modify → Solids Editing → Intersect 

Инструментальная панель: Solids Editing → Intersect 

При вызове команды система выдает повторяющиеся запросы:  

Select objects: (Укажите объекты:) 

Необходимо указать объекты, из общей части которых следует со-

здать новое тело, либо нажать клавишу ENTER для формирования но-

вого тела из ранее указанных и завершения работы с командой. 

Все исходные тела, на основе которых создается новый объект, 

удаляются. Если исходные тела не пересекаются, то в результате 

выполнения команды INTERSECT эти тела будут просто удалены. 
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Команда INTERFERE позволяет проверить, пересекаются ли тела 

одного набора с телами другого набора, и в случае наличия пересече-

ния создать новые объекты, являющиеся общей частью обоих наборов 

Командная строка: INTERFERE 

Выпадающее меню: Modify → Solids → Interfere 

Инструментальная панель: Solids → Interfere 

При вызове команды система выдает повторяющиеся запросы: 

Select first set of solids: 

Select objects: 

(Указание первого набора тел: 

Укажите объекты:)  

Необходимо указать объекты, входящие в первый набор тел, либо 

нажать клавишу ENTER для завершения задания первого набора тел. 

Следующие запросы системы: 

Select second set of solids: 

Select objects: 

(Указание второго набора тел: 

Укажите объекты:) 

Возможные ответы: указать объекты, входящие во второй набор 

тел, либо нажать клавишу ENTER для завершения задания второго 

набора тел. 

Далее система выдает сообщения и запрос: 

Interfering solids (first set): 1 (second set): 1 

Interfering pairs: 1 

Create interference solids? [Yes/No] <N>:  

(Пересекающихся тел (первый набор): 1 (второй набор): 1 

Тел пересечения: 1 

Создать тело пересечения? [Да/Нет] <Нет>:) 

Необходимо нажать клавишу ENTER для задания параметра, 

предложенного по умолчанию. 

Y используется для создания тел, являющихся общими частями 

обоих наборов;  

N используется, если создавать новые тела не требуется. 

Исходные тела, на основе которых создаются новые объекты, не 

удаляют. 
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Команда SECTION позволяет построить сечения (в виде за-

мкнутых областей) твердотельных объектов 

Командная строка: SECTION 

Выпадающее меню: Draw → Solids → Section 

Инструментальная панель: Solids → Section 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 

Необходимо указать объект, сечение которого необходимо по-

строить. 

Далее система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Возможные ответы: указать объекты, сечения которых необхо-

димо построить, либо нажать клавишу ENTER для завершения ука-

зания объектов. 

Следующий запрос системы: 

Specify first point on slicing plane by [Object/ Zax-

is/View/XY/YZ/ZX/3points] <3points>: (Задайте первую точку секущей 

плоскости [Объект/ось Z/Buд/XY/YZ/ZX/3 точки] <3 точки>:) 

Необходимо любым известным способом указать первую точку, 

лежащую на секущей плоскости; при этом система выдает дополни-

тельные запросы: 

Specify second point on plane: (Задайте вторую точку на плоскости:) 

Необходимо любым известным способом указать вторую точку, 

лежащую на секущей плоскости; 

Specify third point on plane: (Задайте третью точку на плоскости:) 

Любым известным способом нужно указать третью точку, лежа-

щую на секущей плоскости, либо нажать клавишу ENTER для зада-

ния параметра, предложенного по умолчанию. 

О используется для задания секущей плоскости, совпадающей с 

плоскостью объекта; при этом система выдает дополнительный за-

прос: 

Select a circle, ellipse, arc, 2D-spline or 2D-polyline: (Укажите 

окружность, эллипс, дугу, 2D-сплайн или 2D-полилинию:) 

Нужно указать объект одного из перечисленных типов, плос-

кость расположения которого следует принять в качестве секущей 

плоскости. 

Z используется для задания секущей плоскости по перпендикуляр-

ной к ней оси; при этом система выдает дополнительные запросы: 
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Specify a point on the section plane: (Задайте точку на секущей 

плоскости:) 

Необходимо любым известным способом указать точку, лежа-

щую на требуемой секущей плоскости; 

Specify a point on the Z axis (normal) of the plane: (Задайте точку 

на оси Z (нормали) плоскости:) 

Нужно любым известным способом указать точку, лежащую на 

перпендикуляре к секущей плоскости, проходящем через первую 

указанную точку. 

V используется для задания секущей плоскости, параллельной 

плоскости видового экрана; при этом система выдает дополнитель-

ный запрос: 

Specify a point on the current view plane <0,0,0>: (Задайте точку 

на плоскости вида <0,0,0>:) 

Любым известным способом нужно указать точку, через кото-

рую должна пройти секущая плоскость, параллельная плоскости 

видового экрана, либо нажать клавишу ENTER для задания коорди-

нат точки, предложенных по умолчанию. 

XY используется для задания секущей плоскости, параллельной 

плоскости XY текущей системы координат; при этом система выда-

ет дополнительный запрос: 

Specify point on XY plane <0,0,0>: (Задайте точку на плоскости XY 

<0,0,0>:) 

Необходимо любым известным способом указать точку, через 

которую должна пройти секущая плоскость, параллельная плоско-

сти XY, либо нажать клавишу ENTER для задания координат точки, 

предложенных по умолчанию. 

YZ используется для задания секущей плоскости, параллельной 

плоскости YZ текущей системы координат;  

ZX используется для задания секущей плоскости, параллельной 

плоскости ZX текущей системы координат. 

После этого система выполнит построение заданных сечений и 

завершит работу с командой. В результате выполнения команды 

создаются объекты типа REGION. При применении к этим объек-

там команды EXPLODE они разбиваются на отдельные линии, дуги 

и окружности. 
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Специальные средства редактирования трехмерных объектов 

 

Команда 3DARRAY создает в пространстве копии объектов в 

виде прямоугольного или полярного массива 

Командная строка: 3DARRAY 

Выпадающее меню: Modify → 3D Operation → 3D Array 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 

Необходимо указать объект, на основе которого следует создать 

массив. 

Далее система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Нужно указать объекты, на основе которых следует создать массив, 

либо нажать клавишу ENTER для завершения указания объектов. 

Следующий запрос системы: 

Enter the type of array [Rectangular/Polar] <R>: (Введите тип 

массива [Прямоугольный/поляРный] <П>:) 

Необходимо нажать клавишу ENTER для задания параметра, 

предложенного по умолчанию. 

R задается для построения прямоугольного массива; 

Р задается для построения полярного массива.  

В режиме создания прямоугольного массива (R) система ведет с 

пользователем следующий диалог: 

Enter the number of rows (—) <1>: (Введите число рядов (—) <1>:) 

Нужно ввести число элементов создаваемого массива вдоль оси Y 

либо нажать клавишу ENTER для задания числа, предложенного по 

умолчанию. 

Следующий запрос системы: 

Enter the number of columns (|||) <1>: (Введите число колонок (|||) 

<1>:) 

Необходимо ввести число элементов создаваемого массива вдоль 

оси X либо нажать клавишу ENTER для задания числа, предложен-

ного по умолчанию. 

Следующий запрос: 

Enter the number of levels (...) <1>: (Введите число уровней (...) 

<1>:) 
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Необходимо ввести число элементов создаваемого массива вдоль 

оси Z либо нажать клавишу ENTER для задания числа, предложен-

ного по умолчанию. 

Следующий запрос системы: 

Specify the distance between rows (—): (Задайте расстояние меж-

ду рядами (—):) 

Необходимо ввести расстояние между соседними элементами 

вдоль оси Y либо задать расстояние, указав на графическом экране 

две произвольные точки. 

Следующий запрос системы: 

Specify the distance between columns (|||): (Задайте расстояние 

между колонками (|||):) 

Нужно ввести расстояние между соседними элементами вдоль 

оси X либо задать расстояние, указав на графическом экране две 

произвольные точки. 

Запрос системы: 

Specify the distance between levels (...): (Задайте расстояние 

между уровнями (...):) 

Необходимо ввести расстояние между соседними элементами 

вдоль оси Z либо задать расстояние, указав на графическом экране 

две произвольные точки. 

После этого система выполнит построение пространственного 

прямоугольного массива и завершит работу с командой. 

В режиме создания полярного массива (Р) система ведет с поль-

зователем следующий диалог: 

Enter the number of items in the array: (Введите число элементов 

массива:) 

Необходимо ввести число элементов, из которых должен состо-

ять создаваемый массив. 

Следующий запрос системы: 

Specify the angle to fill (+=ccw, –=cw) <360>: (Задайте угол для 

построения (+=пчс, –=чс) <360>:) 

Необходимо ввести числовое значение угла, внутри которого 

должны быть равномерно расположены элементы массива (положи-

тельное значение соответствует отсчету против часовой стрелки, а 

отрицательное – отсчету по часовой стрелке), либо нажать клавишу 

ENTER для задания угла, предложенного по умолчанию. 
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Rotate arrayed objects? [Yes/No] <Y>: (Поворачивать элементы 

массива? [Да/Нет] <Да>:) 

Необходимо нажать клавишу ENTER для задания параметра, 

предложенного по умолчанию. 

Y используется, если необходимо, чтобы элементы массива имели 

одинаковую ориентацию относительно оси создаваемого массива;  

N используется, если необходимо, чтобы элементы массива не 

изменяли первоначальную ориентацию в пространстве. 

Следующий запрос системы: 

Specify center point of array: (Задайте центр массива:) 

Нужно любым известным способом указать первую точку, ле-

жащую на оси создаваемого массива. 

Следующий запрос системы: 

Specify second point on axis of rotation: (Вторая точка на оси 

вращения :) 

Необходимо любым известным способом указать вторую точку, 

лежащую на оси создаваемого массива. 

После этого система выполнит построение пространственного 

полярного массива и завершит работу с командой. 

 

Команда MIRROR3D позволяет создать зеркальную копию объ-

ектов относительно произвольно расположенной плоскости 

Командная строка: MIRROR3D 

Выпадающее меню: Modify → 3D Operation → Mirror 3D 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 

Необходимо указать объект, зеркальную копию которого необ-

ходимо создать.  

Далее система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Необходимо указать объекты, зеркальную копию которых необ-

ходимо создать, либо нажать клавишу ENTER для завершения ука-

зания объектов. 

Specify first point of mirror plane (3 points) or [Object/Last/Zaxis/View/ 

XY/YZ/ZX/3points] <3points>: (Задайте первую точку плоскости сим-

метрии (по 3 точкам) или [Объект/Последняя/ось Z/Вид/XY/YZ/ZX/ 

3 точки] < 3 точки>:) 
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Необходимо любым известным способом указать первую точку, 

лежащую на плоскости симметрии; при этом система выдает до-

полнительные запросы: 

Specify second point on mirror plane: (Задайте вторую точку на 

плоскости симметрии:) 

Необходимо любым известным способом указать вторую точку, 

лежащую на плоскости симметрии; 

Specify third point on mirror plane: (Задайте третью точку на 

плоскости симметрии:) 

Необходимо любым известным способом указать третью точку, 

лежащую на плоскости симметрии, либо нажать клавишу ENTER 

для задания плоскости симметрии по трем точкам, как было описа-

но выше. 

О используется для задания плоскости симметрии, совпадающей 

с плоскостью объекта; при этом система выдает дополнительный 

запрос: 

Select a circle, arc or 2D-polyline segment: (Укажите окруж-

ность, дугу или сегмент 2D-полилинии:) 

Необходимо указать объект одного из перечисленных типов, 

плоскость расположения которого следует принять в качестве плос-

кости симметрии. 

L используется для отображения объектов относительно послед-

ней указывавшейся плоскости симметрии. 

Z используется для задания плоскости симметрии по перпенди-

кулярной к ней оси; при этом система выдает дополнительные за-

просы: 

Specify point on mirror plane: (Задайте точку на плоскости сим-

метрии:) 

Любым известным способом необходимо указать точку, лежа-

щую на требуемой плоскости симметрии; 

Specify point on Z axis (normal) of mirror plane: (Задайте точку на 

оси Z (нормали) плоскости симметрии:) 

Необходимо любым известным способом указать точку, лежа-

щую на перпендикуляре к плоскости симметрии, проходящем через 

первую указанную точку. 

V используется для задания плоскости симметрии, параллельной 

плоскости видового экрана; при этом система выдает дополнитель-

ный запрос: 
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Specify point on view plane <0,0,0>: (Задайте точку на плоскости 

вида <0,0,0>:) 

Нужно любым известным способом указать точку, через кото-

рую должна пройти плоскость симметрии, параллельная плоскости 

видового экрана, либо нажать клавишу ENTER для задания коорди-

нат точки, предложенных по умолчанию. 

XY используется для задания плоскости симметрии, параллель-

ной плоскости XY текущей системы координат; при этом система 

выдает дополнительный запрос: 

Specify point on XY plane <0,0,0>: (Задайте точку на плоскости 

XY <0,0,0>:) 

Необходимо любым известным способом указать точку, через 

которую должна пройти плоскость симметрии, параллельная плос-

кости XY, либо нажать клавишу ENTER для задания координат точ-

ки, предложенных по умолчанию. 

YZ используется для задания плоскости симметрии, параллель-

ной плоскости YZ текущей системы координат;  

ZX используется для задания плоскости симметрии, параллель-

ной плоскости ZX текущей системы координат. 

Следующий запрос системы: 

Delete source objects? [Yes/No] <N>: (Удалить исходный объ-

ект? [Да/Нет] <Нет>:) 

Нужно нажать клавишу ENTER для задания параметра, предло-

женного по умолчанию. 

Y используется, если при создании зеркального отображения 

объекта исходный объект необходимо удалить;  

N используется, если исходный объект удалять не надо. 

Далее система выполнит заданные построения и завершит рабо-

ту с командой. 

 

Команда поворота трехмерных объектов относительно произ-

вольно направленной оси ROTATE3D 

Командная строка: ROTATE3D 

Выпадающее меню: Modify → 3D Operation → Rotate 3D 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 

Следует указать объект, который необходимо повернуть. 

Далее система выдает повторяющиеся запросы: 
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Select objects: (Укажите объекты:) 

Необходимо указать объекты, которые необходимо повернуть, 

либо нажать клавишу ENTER для завершения указания объектов. 

Следующий запрос системы: 

Specify first point on axis or define axis by [Object/ 

Last/View/Xaxis/Yaxis/Zaxis/2points]: (Задайте первую точку оси или 

определите угол по [Объект/Последняя/Вид/ось Х/ось Y/ось Z/ 

2 точки]:) 

Необходимо любым известным способом указать первую точку, 

лежащую на оси вращения; при этом система выдает дополнитель-

ный запрос: 

Specify second point on axis: (Задайте вторую точку на оси:) 

Возможные варианты: любым известным способом указать вто-

рую точку, лежащую на оси вращения, либо нажать клавишу 

ENTER для задания оси вращения по двум точкам, как было описа-

но выше. 

О используется для задания оси, соответствующей определенно-

му объекту; при этом система выдает дополнительный запрос:  

Select a line, circle, arc or 2D-polyline segment: (Укажите окруж-

ность, дугу или сегмент 2D-полилинии:) 

Необходимо указать объект одного из перечисленных типов, за-

дающий направление оси вращения. Если в ответ на данный запрос 

будет указан отрезок или прямолинейный сегмент плоской полили-

нии, то в качестве оси вращения будет принята линия, совпадающая 

с этими объектами. Если же будет указана окружность, дуга или 

радиальный сегмент плоской полилинии, то в качестве оси враще-

ния будет принята прямая, перпендикулярная плоскости объекта и 

проходящая через его центр. 

L используется для поворота объектов относительно последней 

указывавшейся оси. 

V используется для задания оси вращения, перпендикулярной 

плоскости экрана; при этом система выдает дополнительный запрос:  

Specify a point on the view direction axis <0,0,0>: (Задайте точку 

на оси направления вида <0,0,0>:) 

Необходимо любым известным способом указать точку, через 

которую должна пройти ось, перпендикулярная плоскости экрана, 

либо нажать клавишу ENTER для задания координат точки, пред-

ложенных по умолчанию. 
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X используется для задания оси вращения, параллельной оси X 

текущей системы координат; при этом система выдает дополни-

тельный запрос: 

Specify a point on the X axis <0,0,0>: (Задайте точку на оси X 

<0,0,0>:) 

Необходимо любым известным способом указать точку, через 

которую должна пройти ось вращения, параллельная оси X, либо 

нажать клавишу ENTER для задания координат точки, предложен-

ных по умолчанию. 

Y используется для задания оси вращения, параллельной оси Y 

текущей системы координат;  

Z используется для задания оси вращения, параллельной оси Z 

текущей системы координат. 

Следующий запрос системы: 

Specify rotation angle or [Reference]: (Задайте угол поворота или 

[Относительно]:) 

Необходимо ввести числовое значение угла поворота объекта 

относительно заданной оси либо задать угол поворота, указав на 

графическом экране две произвольные точки. 

R используется для задания относительного угла поворота. 

Далее система выполнит поворот указанных объектов и завер-

шит работу с командой. 

 

Команда ALIGN позволяет задать положение и ориентацию объ-

екта путем выравнивания его относительно другого объекта 

Командная строка: ALIGN 

Выпадающее меню: Modify → 3D Operation → Align 

Принцип действия данной команды следующий. Последователь-

но указываются две или три пары точек (1 и 2, 3 и 4, 5 и 6), причем 

первая точка из каждой пары ставится в соответствие корректируе-

мому объекту, а вторая – эталонному объекту. Далее система сов-

мещает точки 1 и 2, поворачивает корректируемый объект так, что-

бы совпали линии 1–3 и 2–4, а затем вновь поворачивает объект до 

совмещения линий 1–5 и 1–6. Дополнительно имеется возможность 

изменить масштаб корректируемого объекта до совпадения длин 

отрезков 1–3 и 2–4. 

При вызове команды система выдает первый запрос: 

Select objects: (Укажите объекты:) 
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Необходимо указать объект, положение и ориентацию которого 

необходим изменить. 

Далее система выдает повторяющиеся запросы: 

Select objects: (Укажите объекты:) 

Возможные ответы: указать объекты, положение и ориентацию 

которых необходимо изменить, либо нажать клавишу ENTER для 

завершения указания объектов. 

Следующий запрос системы: 

Specify first source point: (Задайте первую исходную точку:) 

Необходимо любым известным способом указать положение 

точки 1. 

Следующий запрос системы: 

Specify first destination point: (Задайте первую назначенную точку:) 

Необходимо любым известным способом указать положение 

точки 2. 

Следующий запрос системы: 

Specify second source point: (Задайте вторую исходную точку:) 

Необходимо любым известным способом указать положение 

точки 3. 

Следующий запрос системы: 

Specify second destination point: (Задайте вторую назначенную 

точку:) 

Необходимо любым известным способом указать положение 

точки 4. 

Следующий запрос системы: 

Specify third source point or <continue>: (Задайте третью исход-

ную точку или <продолжить>:) 

Необходимо любым известным способом указать положение 

точки 5. В этом случае система запрашивает положение следующей 

точки: 

Specify third destination point: (Задайте третью назначенную точку:) 

Нужно любым известным способом указать положение точки 6 

либо нажать клавишу ENTER, если необходимо выполнить вырав-

нивание объекта только по двум парам точек (без второго поворо-

та); при этом система выдает дополнительный запрос: 

Scale objects based on alignment points? [Yes/No] <N>: (Масшта-

бировать объект до совпадения точек? [Да/Нет] N>:) 
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Необходимо нажать клавишу ENTER для задания параметра, 

предложенного по умолчанию. 

Y используется, если размер корректируемого объекта необхо-

димо изменить до полного совпадения точек;  

N используется, если изменять размер объекта не требуется. 

После этого система соответствующим образом изменит поло-

жение и ориентацию корректируемого объекта и завершит работу с 

командой. Изменение размеров корректируемого объекта возможно 

лишь при выравнивании объектов по двум парам точек. 

 

Варианты заданий 

 

1. Создать твердотельный тор с центром в точке (20,12; 14,08; 

25,36), радиусом образующей 50 мм и диаметром трубы 5 мм. Зер-

кально отобразить полученный элемент относительно плоскости, 

проходящей через точку (17,21; 19,23; 17,89) и параллельной плос-

кости XY. 

2. Создать твердотельный шар с центром в точке (23,56; 24,89; 

54,75) и диаметром 25,19 мм. Создать твердотельный параллелепи-

пед с координатами одной из вершин основания (23,56; 24,89; 

54,75) и размерами 25,36  15,69  85,12 мм. Получить тело, образо-

ванное пересечением построенных фигур. 

3. Построить тело вращения, полученное из прямоугольника с 

размерами 20  40 мм и координатами одного из углов (17,21; 19,23; 

54,23) поворотом относительно прямой, проходящей через точки 

(12,36; 14,08; 23,12) и (26,28; 36,06; 53,26). Выполнить фаски разме-

ром 1,36 под углом 16  у ребер полученной фигуры. 

4. Начертить прямоугольник с размерами 17,35  24,10 мм с ко-

ординатами одного из углов (17,21; 19,23; 15,25). Получить твердо-

тельную модель путем выдавливания построенного прямоугольника 

вдоль оси Z на величину 25,36 мм. Выполнить скругления ребер 

полученной фигуры радиусом 1,25 мм. 

5. Построить твердотельную пирамиду с основанием в виде че-

тырехугольника с координатами одного из углов (17,21; 19,23; 

15,14), размером 12,23  10,12 мм и высотой 13,5 мм. Построить 

твердотельный шар с центром в вершине пирамиды и диаметром 

12,36 мм. Объединить построенные тела в одно. 
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6. Построить твердотельный цилиндр с центром основания в точке 

(12,23; 10,12; 45,12), радиусом 25,3 мм и координатами второго осно-

вания в точке (17,21; 19,23; 24,45). Построить твердотельный шар диа-

метром 12,3 мм с центром в точке (12,23; 10,12; 35,12). Вырезать из 

шара элемент, являющийся общей частью цилиндра и шара. 

7. Создать твердотельную модель, образованную вращением эл-

липса с центром в точке (12,78; 23,56; 36,12), длинами главной оси – 

12 мм, второй оси – 5 мм вокруг оси Z на 270  по часовой стрелке. 

Повернуть построенный объект на 21,23  относительно оси, прохо-

дящей через точки (17,21; 19,23; 15,14) и (12,23; 10,12; 35,12). 

8. Построить трехмерный массив размерностью 2  3  3 мм с 

расстоянием между элементами 12,78 мм, образованный твердо-

тельными шарами радиусом 2,25 мм с центром одного из них в точ-

ке (24,89; 45,12; 23,26). Зеркально отобразить полученный массив 

относительно плоскости XY. 

9. Построить твердотельный конус с центром основания в точке 

(12,78; 23,56; 23,26), радиусом основания 12,52 мм и координатами 

вершины (17,21; 19,23; 24,45). Зеркально отобразить построенный 

объект относительно плоскости, проходящей через точки (17,21; 

19,23; 15,14), (12,23; 10,12; 35,12) и (12,78; 23,56; 36,12). 

10. Начертить эллипс с центром в точке (12,78; 23,56; 16,23) с 

длинами главной оси – 12,23 мм, второй оси – 5,12 мм. Из получен-

ного объекта создать тело вращения вокруг оси, проходящей через 

точки (10,11; 12,02; 13,12) и (18,25; 13,48; 16,28), на угол 47 . 

11. Построить прямоугольную твердотельную призму с коорди-

натами одной из вершин основания (12,26; 5,43; 17,42), противопо-

ложной вершины – (31,67; 16,76; 13,25) и высотой 25,36 мм. Повер-

нуть полученный объект на 125  против часовой стрелки относи-

тельно оси, проходящей через центры окружностей. 

12. Начертить полилинию в точках (10,11; 12,02), (18,25; 13,48), 

(24,89; 45,12). Замкнуть начальную и конечную точки. Построить 

тело вращения из построенной полилинии относительно оси Z на 

угол 18  против часовой стрелки. В ребрах полученной фигуры вы-

полнить скругления радиусом 1,23 мм. 

13. Начертить сплайн в точках (10,11; 12,02), (18,25; 13,48), 

(24,89; 45,12). Замкнуть начальную и конечную точки. Положение 

касательных произвольное. Построить тело путем выдавливания 
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сплайна на длину 26,29 мм с углом сходимости 18 . Повернуть по-

строенное тело относительно оси X на угол 125  по часовой стрелке. 

14. Проверить, пересекаются ли шар диаметром 25,36 мм с коор-

динатами центра (18,25; 13,21; 40,18) и цилиндр с центром основа-

ния в точке (18,25; 25,14; 40,18), радиусом основания 48,26 мм и 

высотой 51,23 мм. В случае пересечения создать твердотельный 

объект, являющийся их общей частью. 

 

Лабораторная работа № 2 

 

ОПТИМИЗАЦИЯ ОСНОВНЫХ ПАРАМЕТРОВ 

ГИДРОПНЕВМАТИЧЕСКОГО ЭЛЕМЕНТА 

ПОДВЕСКИ АВТОМОБИЛЯ 

 

Цель работы: ознакомиться с методикой оптимизации основ-

ных параметров гидропневмоэлемента подвески, исходя из его за-

данной упругой характеристики. 

 

Порядок выполнения: 

1. Ознакомиться с основными теоретическими сведениями по 

данной работе, которые приведены ниже. 

2. Освоить методику получения требуемой упругой характери-

стики подвески и перестроения ее в характеристику упругого эле-

мента. Для заданного варианта исходных данных построить харак-

теристику упругого элемента в безразмерном виде (этот пункт вы-

полняется в контрольной работе). 

3. Ознакомиться с компьютерной программой, реализующей ре-

шение задачи оптимизации параметров гидропневмоэлемента. 

4. Изучить порядок ввода исходных данных для расчета по ком-

пьютерной программе. 

5. Подготовить файл исходных данных spahys.dat в соответ-

ствии с заданным  вариантом и решить задачу на компьютере. 

6. Просмотреть файл результатов расчета spahys.rez и, если ре-

зультаты удовлетворительны, распечатать этот файл для отчета о 

работе. 

 

 



 46 

Основные теоретические сведения 

 

Этапы проектирования подвески. Процесс проектирования 

подвески целесообразно разделить на следующие этапы: 

 выбор требуемых упругой и демпфирующей характеристик 

подвески; 

 выбор типов упругого элемента и демпфера; 

 выбор типа и схемы направляющего устройства и мест уста-

новки упругого элемента и демпфера; 

 определение необходимых характеристик упругого элемента 

и демпфера, обеспечивающих требуемые характеристики подвески; 

 выбор основных конструктивных параметров элементов под-

вески в соответствии с найденными характеристиками; 

 проверочные расчеты деталей подвески. 

 

Из теории гидропневматических упругих элементов. Гидроп-

невматические упругие элементы (ГПЭ) широко применяются в 

подвесках большегрузных автотранспортных средств из-за ряда до-

стоинств: 

 нелинейности упругой характеристики, которая позволяет обес-

печивать приемлемую частоту собственных колебаний подрессоренной 

массы и достаточно большое значение коэффициента динамичности; 

 компактности вследствие высокого рабочего давления газа в 

полостях элемента; 

 возможности регулирования высоты грузовой платформы 

транспортного средства над дорогой. 

На рисунке 4.1 показана схема ГПЭ с противодавлением. У эле-

мента без противодавления отсутствует полость 2. 
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Рисунок 4.1 – Схема гидропневмоэлемента с противодавлением: 

1 – основная полость; 2 – полость противодавления 

 

Усилие, развиваемое ГПЭ с противодавлением, можно записать 

 

э 1 1 2 2 ,F p S p S  

 

где p1 и p2 – давления в основной полости и полости противодавле-

ния соответственно; 

S1 и S2 – площади поршня со стороны названных полостей. 

Давление и объем в полостях ГПЭ связаны между собой соот-

ношениями 

 
б

1 1 constp V  и 
б

2 2 const,p V  

 

где V1 и V2 – объемы газа в полостях ГПЭ; 

α – показатель степени (равен 1 для изотермического процесса, 

1,4 – для адиабатического процесса; Реальное значение показателя 

степени зависит от интенсивности теплообмена с окружающей сре-

дой. Для расчетов рекомендуется принимать α = 1,24). 

Значения давлений в полостях ГПЭ при произвольной нагрузке 

можно определить по формулам 

S1 

2 

 

1 

 

S2 
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1 10 10 1/p p V V   и 2 20 20 2/ ,p p V V  

 

где p10 и V10, p20 и V20 – давления и объемы газа в полостях в поло-

жении статического равновесия. 

При изменении положения поршня ГПЭ при движении автомо-

биля или при загрузке-разгрузке кузова объемы газа в полостях 

можно записать как 

 

1 10 э 1V V h S   и  2 20 э 2V V h S , 

 

где hэ – перемещение поршня относительно положения статическо-

го положения при деформации подвески. 

Усилие на ГПЭ можно представить через его параметры так: 

 
б б

10 20
э 10 1 20 2

20 э 210 э 1

.
V V

F p S p S
V h SV h S

        (4.1) 

 

Обозначим 0 10 1/ ,l V S  0 20 2/L V S  и 20 2

10 1

.
p S

k
p S

 Здесь l0 и 

L0 – приведенные к поршню высоты столбов газа в полостях ГПЭ;  

k – коэффициент противодавления. 

Тогда формула (4.1) будет иметь вид 

 
б б

0 0
э 10 1

0 э 0 э

.
l L

F p S k
l h L h

                (4.2) 

 

Для положения статического равновесия выражение (4.2) имеет вид 

 

э0 10 1 1 .F p S k  

 

Отсюда  
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э0
10 .

1

F
p

k
 

 

Окончательный вид формулы (4.2) следующий: 
 

б б

э0 0 0
э

0 0 э

.
1 э

F l L
F k

k l h L h
                   (4.3) 

 

Из выражения (4.3) следует, что коэффициент противодавления k 

и приведенные высоты столбов газа l0 и L0 в полостях ГПЭ являют-

ся конструктивными параметрами гидропневмоэлемента, влияю-

щими на его упругую характеристику.                       
 

Учет особенностей направляющего устройства подвески. 
Чтобы получить характеристику упругого элемента, обеспечиваю-

щего требуемую характеристику подвески, следует принять тип 

упругого элемента и схему его установки в подвеске. 

Если упругий элемент работает на растяжение-сжатие, то верти-

кальной нагрузке Fу, приведенной к колесу автомобиля, соответ-

ствует осевая нагрузка Fэ упругого элемента. Эти две нагрузки свя-

заны между собой равенством элементарных работ, совершаемых 

при вертикальном перемещении колеса и при осевой деформации 

упругого элемента: 
 

y э эd dF h F h ,                                     (4.4) 

 

где dh и dhэ – элементарные деформации подвески и упругого эле-

мента от исходного положения подвески. 

Из формулы (4.4) можно записать: 
 

э
у э

d
,

d

h
F F

h
 

 

где dhэ / dh – передаточное отношение направляющего устройства 

подвески от колеса автомобиля к упругому элементу. Обозначим 

это отношение через iу. В общем случае данное отношение является 

переменной величиной. 
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С учетом вышеизложенного пересчет упругой характеристики 

подвески производится по формулам 
 

y

э

y

F
F

i
                                            (4.5) 

и 

э y .h i h                                           (4.6) 

 

Формулы (4.5), (4.6) справедливы для многих реальных схем 

направляющих устройств, в которых изменение передаточного от-

ношения в пределах возможного диапазона деформаций очень мало 

и можно принять iу ≈ const. 
 

Методы минимизации функций делятся на три основные группы:  

1) прямые методы, или методы нулевого порядка, алгоритм ко-

торых требует расчета только значений самой функции; 

2) методы первого порядка, использующие при их реализации 

первые производные от функции по оптимизируемым параметрам; 

3) методы второго порядка, требующие расчета вторых произ-

водных от функции по оптимизируемым параметрам. 

Рассмотрим методы минимизации, относящиеся к первой и вто-

рой группам. 

Симплексный метод. Его также называют методом многогран-

ников. Симплекс – это n-мерная замкнутая геометрическая фигура, 

ребра которой представляют собой прямые линии, пересекающиеся 

в (n + 1)-й вершине. На плоскости (двумерное пространство) сим-

плекс – это треугольник; в трехмерном пространстве – тетраэдр. 

Схема поиска минимума функции с использованием симплексов 

основана на слежении за изменением значений функции в вершинах 

симплекса. Главным в схеме поиска является процесс отражения,  

т. е. нахождения вершины нового симплекса, расположенной симмет-

рично относительно плоскости, проходящей через одну из сторон ис-

ходного симплекса. Выбор направления поиска вершины нового сим-

плекса определяется положением той вершины исходного симплекса, 

в которой функция (в задачах оптимизации она называется целевой 

функцией) имеет наибольшее (называемое наихудшим) значение. Но-

вая точка называется дополнением наихудшей точки. 
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Если в новой, только что полученной, вершине нового симплекса 

значение целевой функции окажется меньшим (и значит лучшим,  

т. к. выполняется поиск минимума функции), чем в точке, которая 

была взята для процедуры отражения, то полученный новый сим-

плекс становится исходным.  

Затем в новом симплексе определяется вершина с наихудшим 

значением функции, и описанные действия повторяются. 

Если же в новой вершине значение функции будет больше, чем в 

отраженной, то алгоритм предусматривает возврат к исходному 

симплексу, и выполняется отражение вершины, в которой функция 

имеет второе по величине значение после наихудшей вершины. 

Такой алгоритм обеспечивает систематическое смещение центра 

симплекса в направлении минимума функции. Процесс поиска оста-

навливается, если все попытки отражения полученного на текущем 

этапе симплекса не приводят к улучшению (т. е. уменьшению) значе-

ния целевой функции. Решением задачи минимизации будет наимень-

шее значение функции в одной из вершин текущего симплекса. 

Метод Нелдера–Мида. Данный метод минимизации функций 

относится к методам нулевого порядка и является модификацией 

симплексного метода. 

Он обеспечивает более быстрый поиск минимума функции за 

счет растяжения ребер симплекса в направлении уменьшения ее 

значений и повышения точности поиска за счет сжатия симплекса 

вблизи точки текущего минимума. 

Последовательность работы метода: 

1. Вводится исходный симплекс и рассчитываются значения це-

левой функции Фk(хk) в его (n + 1)-й вершинах. Буквой k обозначен 

номер вершины симплекса (k = 1, 2, ..., n + 1). Буквой n обозначен 

порядок мерности пространства параметров, для которых ведется 

поиск оптимальных значений. Вектор-столбец координат k-й вер-

шины в n-мерном пространстве параметров записывается так: 
 

1

2
.

...

k

k
k

nk

x

x
x

x
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2. Вершины симплекса упорядочиваются по убыванию целевой 

функции. Например, Фn + 1 ≥ Фn ≥ … ≥ Ф2 ≥ Ф1 . 

3. Определяются координаты геометрического центра фигуры, 

состоящей из n лучших вершин, т. е. в эту фигуру не включается, 

например, вершина Фn + 1: 

 

1

1
.

n

c j
j

x x
n

 

 

4. Найденный центр отражается, и координата отраженной точки 

находится по формуле 

 

1б ,r c c nx x x x  

 

где α – положительный коэффициент (чаще принимается равным 1).  

В полученной точке рассчитывают значение целевой функции 

Фr(xr). 

5. Значение целевой функции Фr (xr) сравнивается с ее значения-

ми в вершинах исходного симплекса, и определяется один из вари-

антов последующей работы программы: 

1 вариант – если Ф1 ≤ Фr ≤ Фn , т. е. xr не является лучшей и не яв-

ляется худшей вершиной симплекса, то вершина с координатой xn + 1 

заменяется на xr, и выполняется следующий шаг поиска, начиная с  

п. 2 алгоритма; 

2 вариант – если Фr < Ф1 , т. е. xr является новой лучшей верши-

ной, то направление отражения считается удачным и предпринима-

ется попытка растянуть симплекс в этом направлении. Для этого 

рассчитывается координата новой точки 

 

в ,e c r cx x x x  

 

где β – коэффициент растяжения (он должен быть больше 1, обычно 

принимается равным 2). 

Потом определяется соответствующее этой точке значение целе-

вой функции Фe(xe). 
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Если Фe(xe) < Фr(xr), то попытка растяжения является успешной, 

xn + 1 заменяется на xe, и выполняется возврат к п. 2 алгоритма для 

продолжения поиска на новом шаге. 

Если же  Фe(xe) ≥ Фr(xr), то вершина с координатой xn + 1 заменяется 

на вершину xr, и поиск продолжается возвратом в п. 2 алгоритма; 

3 вариант – если Фr(xr) > Фn(xn), то делается заключение, что 

симплекс слишком велик и его надо сжать. Для этого рассчитывает-

ся координата новой точки 
  

1 1

1

г , если Ф Ф
,

г , если Ф Ф

c n c r n

i

c n c r n

x x x
x

x x x
 

 

где γ – коэффициент сжатия; принимает значения от 0 до 1 и обыч-

но приравнивается к 0,5. 

Если найденное в новой точке значение функции Фi(xi) < min(Фr (xr), 

Фn + 1(xn + 1)), то цель сжатия достигнута, и вершина симплекса с ко-

ординатой xn + 1 заменяется на вершину с координатой xi. После это-

го решение задачи продолжается с п. 2 алгоритма. 

Если же значение функции Фi(xi) ≥ min(Фr (xr), Фn + 1(xn + 1)), про-

изводится ускоренная замена текущего симплекса новым, коорди-

наты вершин которого определяются по выражению 
 

1 / 2.k kx x x  

 

Здесь k = 2, 3, … , n + 1. 

После этого проводится проверка условия останова решения за-

дачи. Если 
 

1

1

е,kx x

x
 

 

где ε – заданная относительная погрешность решения, то условие 

сходимости результата считается достигнутым. Процесс решения 

задачи останавливается. 
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В случае невыполнения условия рассчитывается значение целе-

вой функции в вершинах нового симплекса, и процедура поиска 

продолжается после возврата к п. 2 алгоритма. 

Градиентные методы. Градиентом функции Ф(x) векторного 

аргумента x = (x1, x2 , …, xn) называется вектор, координатами кото-

рого являются частные производные от функции по соответствую-

щим переменным: 

 

1 2

Ф Ф Ф
Ф , ,..., .

nх х х
 

 

Геометрически градиент функции представляется в виде вектора, 

направленного в сторону наиболее быстрого возрастания функции. 

Вектор, называемый антиградиентом, направлен в сторону наиболее 

быстрого убывания функции Ф(x). Это означает, что продвижение в 

направлении антиградиента в окрестностях точки, в которой он опре-

делен, позволит достичь меньшего значения функции, чем перемеще-

ние на то же расстояние по любому другому направлению. 

На данном свойстве антиградиента основано его использование 

для поиска оптимального решения задачи. Упрощенно принцип ра-

боты градиентных методов минимизации функций можно предста-

вить следующим образом: 

1. В исходной точке поиска с координатой x0 определяется 

направление антиградиента. 

2. Вдоль этого направления выполняется шаг заданной длины. 

3. В полученной таким образом новой точке опять определяется 

направление антиградиента и т. д. Процесс проводится до тех пор, 

пока идет убывание функции, т. е. пока улучшается результат. 

Отличие разных градиентных методов друг от друга состоит в 

способе выбора длины шага и направления поиска на каждой ите-

рации. 

Наиболее простым методом является тот, в котором движение 

вдоль выбранного направления антиградиента выполняется с по-

стоянным шагом: 
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1 ф

Ф
,

Ф Ф
k kx x h  

 

где k и (k + 1) – номера предыдущей и текущей итераций поиска;  

Ф Ф
τ 
 – модуль градиента. 

 
2

1

Ф
Ф Ф .

n

j ix
 

 

Если значение функции в новой точке оказывается больше ее 

значения в предыдущей точке, т. е. Фk + 1(xk + 1) > Фk(xk), то произво-

дится возврат в предыдущую точку. Потом величина шага делится 

пополам, и процесс продолжается с уменьшенным шагом. Процесс 

решения задачи останавливается, когда величина шага оказывается 

меньше некоторого заданного малого числа δ или когда модуль гра-

диента становится меньше заданной погрешности ε.  

В некоторых случаях более эффективным является поиск с ша-

гом, пропорциональным модулю градиента (xk + 1 = xk – h Ф). 

Еще более совершенным градиентным методом является метод 

наискорейшего спуска, в котором используется поиск вдоль одного 

направления. Его особенность состоит в том, что после получения 

направления антиградиента в исходной точке определяется точка 

относительного минимума функции в этом направлении. Потом в 

этой точке снова рассчитывается антиградиент, и процесс повторя-

ется до тех пор, пока последующие итерации позволяют уменьшать 

значение функции. 

 

Компьютерная программа оптимизации основных параметров 

гидропневматического элемента подвески 

 

Программа с условным наименованием SPAHYS предназначена 

для определения оптимальных значений основных параметров ГПЭ 

подвески, которые обеспечивают наиболее полное совпадение ее 

расчетной упругой характеристики с требуемой характеристикой.  

В названной программе оптимальные значения параметров эле-

мента находятся по минимуму целевой функции, оценивающей от-
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клонение расчетной упругой характеристики ГПЭ от требуемой ха-

рактеристики на каждом шаге поиска. Рассматривается безразмер-

ный вид упругой характеристики, получаемый из характеристики 

обычного вида (см. формулу (4.3)) пересчетом по выражениям (3.2) 

и (3.3). 

Целевая функция представлена в программе выражением 
 

э , 1

э ,

2 2
*

э э э Д Д Д
1э , 1 э 1

1
Ф d ,

w i

w i

hn

i k w w w
i hw n w

C C F F h C K K
h h

 (4.7) 

 

где n – количество участков с различной значимостью совпадения 

упругих характеристик в пределах диапазона перемещений поршня; 

hэw, i и hэw, i + 1 – границы i-го участка;  

Сi – весовой коэффициент значимости совпадения характери-

стик на i-м участке; 

Д – коэффициент динамичности расчетной характеристики 

(определяется по формуле Д = Fэw, n + 1 + 1); 
*
ДK  – коэффициент динамичности требуемой характеристики 

(определяется по формуле *
ДK  = э , 1 1w nF ); 

СД – коэффициент штрафа за несовпадение коэффициентов ди-

намичности (принимается положительным, если *
Д ДK K , и отри-

цательным, если *
Д ДK K ; 

Ck – коэффициент коррекции значения целевой функции для 

обеспечения более полного совпадения характеристик вблизи ис-

ходного положения (на ходе сжатия Ck = exp[(hэw, n + 1 – hэw)/ hэw, n + 1; 

на ходе отбоя Ck = exp[(hэw, i + hэw) / hэw, i; при отсутствии коррекции 

коэффициент равен 1). 

Для определения значений параметров ГПЭ, обеспечивающих 

максимальное совпадение требуемой и расчетной характеристик, в 

программе используются усовершенствованный симплексный ме-

тод Нелдера–Мида и метод переменной метрики Флетчера, относя-

щийся к градиентным методам.
 

 

Структура программы. Программа включает головной модуль, 

процедуры и подпрограммы-функции. 
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Головной модуль осуществляет ввод исходных данных и вывод 

результатов расчетов. 

Процедуры и подпрограммы-функции служат для: 

MINI – организации минимизационных процессов; 

MIN – организации обращения к процедурам минимизации; 

MIN1 – реализации симплексного метода Нелдера–Мида; 

MIN8 – реализации градиентного метода Флетчера; 

LIRE – обращения к процедурам поиска вдоль направления; 

LIRE3 – реализации метода первого приемлемого решения с до-

полнительной попытки; 

GRAD – вызова процедуры расчета градиента целевой функции; 

GRAD3 – расчета значений координат графика целевой функции; 

OKKU2 – расчета значений целевой функции; 

QATR – расчета значений определенного интеграла заданной 

функции; 

FCTF – вычисления корректированного значения квадрата не-

вязки расчетной и требуемой характеристик ГПЭ; 

DELW – вычисления значения невязки характеристик ГПЭ; 

DWDA, DWDB, DWDC – расчета значений производных харак-

теристики ГПЭ по ее параметрам; 

W – вычисления значения безразмерной силы ГПЭ при заданном 

перемещении поршня ГПЭ; 

FUNCW – расчета значений аналитически заданной безразмер-

ной характеристики ГПЭ; 

JAALGR – реализации метода интерполяции Лагранжа; 

FUNCC – вычисления коэффициента корректировки подынте-

грального выражения целевой функции. 
 

Подготовка исходных данных. Ввод исходных данных осу-

ществляется из файла с именем SPAHYS.DAT, который должен 

находиться в одном каталоге с выполняемым файлом программы 

SPAHYS.EXE. 

Файл исходных данных имеет следующий вид: 

«Файл содержит исходные данные к программе SPAHYS определе-

ния основных параметров гидропневморессоры по заданной харак-

теристике. При этом характеристика может задаваться функцией 

вида W = f(Del), где W – безразмерная сила; Del – перемещение 

поршня рессоры от исходного положения, или массивом точек 
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W(1), …, W(N), соответствующих значениям перемещения поршня 

Del(1), …, Del(N). В первом случае необходима дополнительно про-

грамма-функция FUNCW(Del). Подробно составление этой подпро-

граммы написано в инструкции к программе SPAHYS. 

Петров И.И., гр.101115. «Определение упругой характеристики ГПР» 

1. Начальное значение, нижняя и верхняя граница значений приве-

денной высоты столба газа в основной полости гидропневморессо-

ры [мм]: 

400.,115.,500. 
2. Начальное значение, нижняя и верхняя граница значений коэф-
фициента противодавления (для рессоры без противодавления за-
даются три нулевых значения): 
0.,0.,0.7 
3. Начальное значение, нижняя и верхняя граница значений приве-
денной высоты столба газа в полости противодавления [мм] (для 
рессоры без противодавления можно задавать любые значения): 
390.,115.,500. 
4. Показатель политропы (от 1,0 для изотермического процесса до 
1,4 для адиабатического): 
1,25 
5. Признак способа представления заданной характеристики (1 – 
при описании аналитической функцией, 0 – при наличии узловых 
точек): 
0, 
6. Признак необходимости корректировки значения целевой функ-
ции для повышения значимости совпадения заданной и реальной 
характеристик вблизи исходного положения (1 – при наличии кор-
ректировки, 0 – при отсутствии корректировки): 
0, 
7. Коэффициент штрафа за превышение заданного коэффициента 
динамичности 
0, 
8. Коэффициент штрафа за снижение заданного коэффициента ди-
намичности: 
0, 
9. Число участков характеристики  с различной значимостью совпа-
дения (не более 20): 
1, 
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10. Границы участков характеристики по перемещению поршня от 
полного отбоя до полного сжатия [мм] (число граничных точек на 1 
больше числа выделенных участков, данные вводятся по 4 значения 
в строку, общее число точек не более 21): 
–110.,110. 
11. Весовые коэффициенты значимости каждого участка характери-
стики; максимально допустимое значение относительной погреш-
ности вычисления интеграла несовпадения характеристик на каж-
дом участке; максимально допустимое число делений участка при 
интегрировании (не более 50). Количество строк соответствует ко-
личеству участков характеристики: 
1.Е4,1.Е-2,50, 
12. Количество точек заданной и оптимизированной характеристик 
гидропневморессоры (включая полный отбой и полное сжатие), вы-
водимых на печать: 
11, 
13. Число процедур или последовательностей процедур минимиза-
ции, начальная точка для которых задается датчиком псевдослучай-
ных чисел (если для минимизации достаточно одной начальной 
точки, эта величина равна 0): 
0, 
14. Длина последовательности процедур минимизации (количество 
последовательно вызываемых методов поиска оптимального реше-
ния, не более 19): 
1, 
15. Признак управления выводом на печать IPR: 

IPR < 1 – подробная печать результатов промежуточных итераций; 
IPR = 1 – печать только окончательных результатов по каждой 

процедуре минимизации; 
IPR > 1 – печать только окончательных результатов минимизации: 

1, 
16. Признак выбора метода минимизации функции (1 или 8 – под-
ключаются при работе процедуры MIN1 и MIN8). Количество строк 
соответствует длине последовательности процедур минимизации: 
8, 
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17. Критерий останова программы по относительному приращению 

значений параметров: 

1.Е-3 

18. Критерий останова программы по относительному приращению 

значений целевой функции: 

1.Е-4 

19. Контрольное (удовлетворительное) значение целевой функции, 

при достижении которого минимизация прекращается: 

0. 

20. Предполагаемое экстремальное значение целевой функции: 

0. 

21. Количество точек заданной характеристики (не более 41, но при 

наличии аналитической зависимости это значение не используется): 

11, 

22. Координаты точек заданной характеристики (вводятся в виде: 

перемещение поршня в мм, безразмерная сила). Количество строк 

соответствует числу узловых точек характеристики. При наличии 

аналитической зависимости эти значения не используются: 

–110.,–0.632 

–97.,–0.551 

–72.,–0.451 

–48.,–0.33 

–24.,–0.181 

   0.,0. 

25.,0.221 

49.,0.492 

73.,0.823 

97.,1.225 

110.,1.718   »                 {конец примера файла исходных данных} 

 

Для подготовки нового варианта исходных данных следует отре-

дактировать файл SPAHYS.DAT, руководствуясь следующими пра-

вилами: 

1. Несколько начальных строк содержат комментарии к файлу и 

не должны изменяться пользователем. 

2. Следующая строка предназначена для названия расчета, номе-

ра группы и Ф.И.О. студента. 
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3. Каждой из содержащихся далее в тексте числовых величин 

предшествует комментарий, редактировать который не следует. 

Изменения могут вноситься только в следующие за текстом число-

вые данные. При необходимости число строк данных в пп. 10, 11, 

16 и 22 можно увеличивать или уменьшать. 

4. Значения величин в строках вводятся, начиная с первой пози-

ции. Запятые, отделяющие числа друг от друга и стоящие после це-

лых чисел, обязательны. 

5. После завершения редактирования файла исходных данных он 

сохраняется с внесенными изменениями. 

Запуск программы для расчета. В каталоге программы нужно 

выделить курсором файл SPAHYS.EXE и запустить программу на 

выполнение. 

Результаты расчета. Результаты заносятся в файл SPAHYS.REZ, 

находящийся в каталоге программы. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 62 

ПРИЛОЖЕНИЕ 

 

Образец оформления титульного листа контрольной работы 

 

 

Белорусский национальный технический университет 

 

 

Кафедра –––––––––––––––––––––––––––––– 

 

 

 

КОНТРОЛЬНАЯ РАБОТА 

 

по дисциплине_________________________________________ 

 

 

Тема:_____________________________________________________

__________________________________________________________

__________________________________________________________ 

 

 

Выполнил: __________________________ (фамилия, инициалы) 
                                        (подпись) 

 

студент_____________курса,______________ группы 
 

Шифр_________________________________________ 
 

Домашний адрес________________________________ 

 

 

 

 

 

 

 

 
Минск 20––

Автомобили 

САПР узлов и механизмов автомобилей 



ОГЛАВЛЕНИЕ 

 

ВВЕДЕНИЕ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3 

1. КОНТРОЛЬНЫЕ ВОПРОСЫ ПО ДИСЦИПЛИНЕ. . . . . . . . . . . . .4 

2. СПИСОК РЕКОМЕНДУЕМОЙ ЛИТЕРАТУРЫ. . . . . . . . . . . . . . . 7 

3. КОНТРОЛЬНАЯ РАБОТА. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8 

3.1. Требования к оформлению. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8 

3.2. Задания. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .8 

3.3. Методические указания к выполнению задания 2. . . . . . . . . .12 

4. ЛАБОРАТОРНЫЕ РАБОТЫ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17 

Лабораторная работа № 1 

Компьютерная графика в программном пакете AutoCAD. . . . . . . . .17 

Лабораторная работа № 2 

Оптимизация основных параметров гидропневматического 

элемента подвески автомобиля. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .45 

ПРИЛОЖЕНИЕ. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .62 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

Учебное издание 

 

 

РУКТЕШЕЛЬ Олег Степанович 

ДЫКО Геннадий Александрович 

СИДОРОВ Сергей Алексеевич 

 

 

САПР УЗЛОВ И МЕХАНИЗМОВ 

АВТОМОБИЛЕЙ 
 

 

Учебно-методическое пособие 

для студентов специальности 1-37 01 02 

«Автомобилестроение (по направлениям)» 

направления 1-37 01 02-01 «Автомобилестроение (механика)» 

специализации 1-37 01 02-01 01 «Грузовые автомобили» 

 

 

 

Редактор В. О. Кутас 

Компьютерная верстка А. Г. Занкевич 

 
Подписано в печать 28.06.2012. Формат 60 84 1/16. Бумага офсетная. Ризография. 

Усл. печ. л. 3,72. Уч.-изд. л. 2,91. Тираж 100. Заказ 1090. 

Издатель и полиграфическое исполнение: Белорусский национальный технический  
университет. ЛИ № 02330/0494349 от 16.03.2009. Пр. Независимости, 65. 220013, г. Минск. 

 




